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We’re	making	it	easy	to	collaborate	on	an	email	draft	in	Docs	with	the	new	email	draft	template.	You	can	mention	people	in	the	recipient	fields	using	the	@	menu	without	having	to	remember	their	email	addresses,	and	collaborate	on	the	message	body	using	comments	and	suggestions.	When	ready	to	send,	simply	click	the	button	that	is	shown
alongside	an	email	draft.	A	Gmail	compose	window	will	pop	up,	with	email	fields	(subject,	to,	cc,	bcc,	and	body)	automatically	populated	based	on	the	email	draft	in	the	document.Creating	an	email	draft	templateGetting	started	Admins:	There	is	no	admin	control	for	this	feature.	End	users:	There	is	no	end	user	setting	for	this	feature.	To	insert	an	email
template,	go	to	Insert	>	Building	Blocks	>	Email	draft	Rollout	pace	Availability	Available	to	all	Google	Workspace	customers,	as	well	as	legacy	G	Suite	Basic	and	Business	customers	Google	Workspace	Learning	Center	Creating	the	same	types	of	files	over	and	over	can	be	time-consuming	and	inconsistent	across	team	members.	Save	time	with
templates	in	Google	Docs,	Sheets,	Slides,	Forms,	or	Sites.	You	can	choose	an	existing	template	or	create	your	own.	Examples	Create	eye-catching	resumes,	brochures,	or	newsletters	instantly	using	Docs.	Get	an	instant	format	for	invoices,	budgets,	expense	reports,	or	schedules	in	Sheets.	Make	your	sales	pitch,	case	study,	proposal,	or	status	report
stand	out	with	a	Slides	presentation.	Promote	your	organization	by	creating	branded	templates	for	external-facing	documents,	such	as	proposals	and	reports,	using	any	of	the	Docs	editors.	Add	signatures	to	an	agreement,	flowcharts	to	a	process	document,	import	metrics	into	a	spreadsheet,	and	more	with	add-ons.	Choose	an	option:	From	the	Docs,
Sheets,	Slides,	Forms,	or	Sites	home	screen,	at	the	top,	select	one	of	the	featured	templates.	Click	Template	gallery	to	see	additional	templates.	Note:	If	you	can't	find	Template	gallery,	go	to	Display	or	hide	Template	gallery.	If	you	already	have	a	file	open	in	one	of	the	Docs	editors,	click	FileNewFrom	template	and	select	the	template	you	want.	From
Drive,	click	New	and	next	to	Google	Docs,	Sheets,	Slides,	Forms,	or	Sites	point	to	the	Right	arrow		and	click	From	a	template.	You	can	use	this	feature	only	if	your	organization	supports	it.	For	help,	contact	your	administrator.		Choose	an	option:	Create	a	new	document,	spreadsheet,	presentation,	form,	or	site.	Open	an	existing	document,	spreadsheet,
presentation,	form,	or	site	and	make	the	changes	you	want	for	your	template.	Note:	If	your	template	file	is	in	a	shared	drive,	check	the	sharing	settings	on	the	shared	drive.	Sharing	restrictions	can	prevent	people	from	accessing	the	template.	See	Share	and	collaborate	in	shared	drives.	From	the	Docs,	Sheets,	Slides,	Forms,	or	Sites	home	screen,	at
the	top,	click	Template	galleryyour	organization	name.	Note:	If	you	can't	find	Template	gallery,	go	to	Display	or	hide	Template	gallery.	Click	Submit	template.	Important:	You	won't	be	able	to	submit	a	template	if	you	do	not	have	permission	to	modify	the	sharing	settings	of	your	template,	or	if	the	template	sharing	settings	have	been	set	to	restrict
viewers	and	commenters	from	downloading	the	file.	Click	Select	a	document	and	choose	the	template	file	you	created.	Click	Open.	(Optional)	To	submit	a	copy	of	the	file	instead	of	the	original,	check	the	box.	Select	a	category	for	your	file.	Click	Submit.	To	find	your	new	template,	go	to	Template	galleryselect	your	template.	Open	Docs,	Sheets,
Slides,	Forms	or	Sites.	At	the	top,	click	Menu	Settings.	Check	the	Display	recent	templates	on	home	screens	box	and	click	OK.	If	you	hide	Template	gallery,	you	can	still	get	to	the	templates,	if	needed.	At	the	bottom	of	Docs,	Sheets,	Slides,	Forms,	or	Sites,	point	to	New		and	click	Choose	template		to	open	the	gallery.	SearchClear	searchClose
searchGoogle	appsMain	menu	Browse	a	large	gallery	of	professionally	designed	templates,	including	calendars,	schedules,	invoices,	time	sheets,	budgeting	tools,	letters,	resumes,	financial	calculators,	and	more.	When	you	find	a	template	you	want	to	use,	click	on	the	Copy	to	Google	Drive	button	and	the	add-on	will	save	a	copy	of	the	template	into	the
root	folder	of	your	Google	Drive.	Features:	-	Get	access	to	templates	not	available	in	the	public	gallery	-	Get	templates	for	both	Docs	and	Sheets	-	Search	by	keyword	Visit	the	feedback/support	page	on	vertex42.com	to	request	other	templates.	Clarification	on	permissions	required	by	this	add-on:	This	add-on	requires	the	use	of	the	Google	Drive	API	to
copy	a	spreadsheet	or	document	template	to	your	Google	Drive.	It	does	not	access,	update,	or	delete	other	documents,	spreadsheets,	or	folders	on	your	Google	Drive.Template	Gallery	for	Docs	will	ask	for	the	permissions	shown	below.	Learn	moreTemplate	Gallery	for	Docs	will	need	access	to	your	Google	accountThis	will	allow	Template	Gallery	for
Docs	to	:See,	edit,	create,	and	delete	all	your	Google	Docs	documentsSee,	edit,	create,	and	delete	all	of	your	Google	Drive	filesSee,	edit,	create,	and	delete	all	your	Google	Sheets	spreadsheetsDisplay	and	run	third-party	web	content	in	prompts	and	sidebars	inside	Google	applicationsSee	your	primary	Google	Account	email	addressSee	your	personal
info,	including	any	personal	info	you've	made	publicly	available	Next:	Train	your	Drive	usersSupported	editions	for	this	feature:	Business	Standard	and	Business	Plus;	Enterprise;	Education	Fundamentals,	Education	Standard,	Teaching	and	Learning	Upgrade,	and	Education	Plus;	Nonprofits;	G	Suite	Basic	and	G	Suite	Business;	Essentials.	
Compare	your	edition	Using	Google	Docs,	Sheets,	Slides,	Forms,	and	Sites	templates	in	the	template	gallery,	you	can	create	formatted	files,	such	as	project	plans	or	budgets.	You	can	also	create	a	custom	template	gallery	using	both	standard	templates	and	templates	you	and	your	users	create	if	you	enable	custom	templates.	In	the	Google	Admin
console,	you	can	manage	the	categories	for	your	organization’s	custom	template	gallery	or	turn	it	off	altogether.	Regardless	of	settings,	you	can	add	and	remove	templates	you	or	your	users	created.	You	can’t,	however,	remove	templates	in	the	Google	template	gallery.	For	more	information,	go	to	Create	document	templates.	Enable	custom	templates
Allow	users	in	your	organization	to	find	and	use	organization-specific	templates	from	the	Docs,	Sheets,	Slides,	Forms,	and	Sites	home	screens.	Update	the	template	categories	so	users	can	quickly	find	relevant	templates.	For	example,	you	might	want	separate	categories	for	your	marketing,	sales,	and	human	resources	teams.	Check	the	Enable	custom
templates	for	your	organization	box.	If	this	box	isn't	checked,	users	can’t	submit	or	use	custom	templates,	but	they	can	still	use	the	standard	template	gallery.	(Optional)	To	help	users	quickly	find	relevant	templates,	update	the	template	categories.	To	add	a	category—Enter	a	category	name	and	click	Add.	To	remove	a	category—Uncheck	the
category's	box.	When	you	remove	a	category,	you	see	an	option	to	move	its	existing	templates.	If	you	don’t	select	a	new	category,	existing	templates	appear	in	the	gallery	as	Uncategorized.	Select	who	can	submit	templates:	Open—Anyone	in	your	organization	can	add	or	remove	templates	without	approval.	Moderated—Admins	with	the	Docs
Templates	privilege	get	an	email	request	to	approve	each	new	template.	The	request	is	closed	once	any	admin	responds.	Approved	templates	are	added	to	the	custom	gallery.	Rejected	templates	can	be	resubmitted.	Restricted—Only	admins	with	the	Docs	Templates	privilege	can	submit	templates.	Click	Save.	Turn	on	templates	with	add-ons	You	can
pair	Docs,	Sheets,	Slides,	Forms,	and	Sites	templates	with	recommended	add-ons.	Add-ons	are	third-party	tools	that	work	with	Docs	editors.	For	example:	A	legal	template	might	include	an	add-on	for	electronic	signatures.	A	project	plan	template	might	include	an	add-on	to	create	flow	charts	and	other	complex	diagrams.	When	users	create	a	new
document	from	a	template,	a	sidebar	shows	any	paired	add-ons.	This	sidebar	makes	it	easy	to	find	and	install	the	right	tools	for	a	task.	Learn	more	about	using	and	submitting	templates.	Allow	templates	with	add-ons	in	your	organization:	G	Suite	Tips	is	provided	by	the	team	at	Overdrive.	We’re	passionate	about	Google	Workspace	and	everything
Google,	so	we’re	delighted	to	share	the	latest	insights,	tips	and	tricks	with	you.	Google	Docs	add-ons	operate	similarly	to	Chrome	extensions.	They	are	a	third-party	apps	that	you	can	install	to	add	new	features	to	Google	Docs.	Here's	how	to	set	them	up,	and	uninstall	them	when	they’re	no	longer	needed.	It's	hard	to	find	a	better	word	processor	than
Google	Docs.	You	can	use	it	to	write	work	papers,	articles,	create	a	resume,	and	so	on.	However,	if	you're	a	power	user,	the	built-in	capabilities	of	Google	Docs	may	not	be	sufficient.	To	fix	that,	you	can	use	Google	Docs	add-ons	to	add	functionality	that	fills	in	the	gaps.	Some	add-ons	boost	productivity,	while	others	expand	capabilities	(like	allowing
teachers	to	integrate	grades	into	students'	papers).	How	to	install	Google	Docs	Add-Ons	Open	any	Google	document	on	the	web.	From	the	top	menu,	select	Extensions	>	Add-ons	>	Get	add-ons.	A	Google	Workspace	Marketplace	pop-up	window	will	open	with	apps	that	work	with	Google	Docs.	Choose	the	one	you	want	to	add	and	click	Install.	A
message	will	appear	to	inform	you	about	the	specific	data	the	add-on	needs	to	access	to	work	properly.	Read	the	message,	then	click	Allow.	After	the	installation,	you	may	need	to	refresh	the	Google	Docs	page	to	start	using	the	add-on.	How	to	uninstall	Google	Docs	Add-Ons	Open	any	Google	document	on	the	web.	From	the	top	menu,	select
Extensions	>	Add-ons	>	Manage	add-ons.	A	Google	Workspace	Marketplace	pop-up	window	will	open	with	the	list	of	add-ons	currently	installed.	Click	on	the	one	you	want	to	remove,	and	then	click	Uninstall.	A	pop-up	message	will	appear	to	confirm	the	action.	6.	Refresh	the	page	to	make	sure	the	changes	take	effect.	Check	out	some	of	our
recommended	Google	Workspace	add-ons	to	improve	productivity	and	boost	security	within	your	company.	Share	your	favorite	Google	Docs	add-ons	on	our	Google	Workspace	forum	.	Google	Drive	can	be	used	to	upload	files	that	are	meant	to	be	private	or	confidential.	If	you	are	looking	for	a	way	to	hide	files	within	a	shared	folder	or	shared	drive,	this



tip	is	for	you.	No	one	can	view	the	files	created	or	uploaded	to	My	Drive	until	you	share	them.	But	what	if	you	want	to	conceal	files	that	are	part	of	a	shared	folder	or	drive	in	Google	Drive?	Keep	in	mind	that	the	following	trick	works	only	with	files	that	are	uploaded	to	Google	Drive	(e.g.	PDFs,	Microsoft	Office	files,	images	etc)	and	not	the	ones	created
in	Google	Drive	such	as	Docs,	Sheets	etc.	Use	File	Versions	to	Hide	PDFs	and	other	files	in	Google	Drive	If	you	have	editor	rights	on	a	shared	file,	you	can	use	Google	Drive’s	version	management	feature	to	hide	the	original	file.	This	will	render	the	original	file	hidden	in	plain	sight.	Here’s	how	to	change	the	file	version	and	hide	the	original	file	in
Google	Drive:	Open	Google	Drive	on	the	web.	Right-click	on	the	file	you	want	to	hide	and	select	Manage	versions	(you	can	only	do	this	if	you	have	Editor	permissions	on	the	file).	Click	Upload	new	version.	Upload	any	file	you	want	to	put	in	front	of	the	original.	To	make	it	less	noticeable,	you	should	use	the	same	file	format	as	the	original	file.	If	it's	a
PDF	document,	make	sure	you’re	uploading	a	PDF	file;	if	it's	a	JPEG	or	PNG	image,	use	an	image;	and	so	on.	Remember,	this	only	works	with	files	uploaded	to	Google	Drive,	not	those	generated	in	Google	Docs,	Sheets,	and	Slides.	Here’s	an	important	step:	click	on	the	3-dots	menu	next	to	the	original	file	and	make	sure	the	Keep	forever	box	is
checked.	The	original	file	will	be	deleted	after	30	days	if	you	miss	this	step.	Once	the	file	is	uploaded	click	the	Close	button.	In	case	you	want	to	unhide	the	file	and	bring	the	original	back	to	Google	Drive	in	plain	sight,	right-click	on	the	file	>	Manage	versions	>	Delete	the	uploaded	file	that	you	used	to	mask	the	original	one.	The	downside	of	this	trick
is	that	the	Owner	of	the	file,	as	well	as	the	Editors,	can	still	see	the	original	file	if	they	check	the	file’s	version	history.	If	you	have	discovered	a	better	way	to	hide	files	in	Google	Drive,	share	your	tip	with	others	on	the	Google	Workspace	forum	.	Did	you	know	that	you	can	search	Google	Drive	for	files	that	are	owned	by	you,	or	others?	You	can	use	this
feature	to	separate	your	files	from	the	ones	owned	by	your	colleagues	or	external	users.	Take	advantage	of	this	search	feature	to	save	time.	Google	Drive	is	an	online	storage	service	that	allows	Google	Workspace	to	store	and	share	files.	The	service	syncs	documents,	images,	and	other	files	across	all	of	the	user's	devices,	including	mobile	phones,
tablets,	and	computers.	Google	Drive	allows	you	to	organize	files	inside	standard	folder	hierarchies,	as	well	as	locate	folders	and	files	using	traditional	navigation	techniques	(e.g.	clicking	down	through	a	folder	hierarchy).	However,	it	is	usually	faster	to	use	Google	Drive's	fantastic	search	capabilities.	To	find	all	the	files	owned	by	you	within	your
company’s	Google	Drive,	click	on	the	search	box	and	enter	creator:	followed	by	your	email	address.	For	example,	creator:	[email	protected]	.	You	can	use	this	trick	with	any	email	address	from	within	your	company’s	domain	(e.g.	creator:	[email	protected]	)	You	can	also	use	the	advanced	search	filters	such	as	Location,	File	Type,	Last	Modified,	and
Labels	to	narrow	your	search.	You	can	now	find	files	in	Google	Drive	more	precisely	and	faster	with	this	advanced	search	tip.	For	more	Google	Drive	search	shortcuts	check	out	this	tip	.	Ask	for	help	or	share	your	Google	Drive	tips	with	the	community	on	our	dedicated	Google	Workspace	forum	.
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